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Program Options - General

View History remembers

Details tab

When checked, the View menu history remembers the tab in the Details window that was

in use, as well as the previous focus persons.

Checked

Open Picklist to current

Focus Person

When checked, the Picklist will open with the highlight on the current focus person.

When not checked, it will open at the top.

Checked

Show status bar When checked, a status bar appears at the bottom of the screen which gives information

on the status (off/on) of Insert, NumLock, Scroll Lock, and Caps Lock keys. When these

keys are on, the words are bolded.

Checked

Show Cue Cards When checked, tips about how to do various functions will appear the first time you enter

a particular screen. 

! You can turn off the Cue Card for a particular screen by deselecting Show this cue

card again next time in the Cue Card window. 

! In addition, you can right-click on the Help button in any screen to trigger a Cue

Card for that screen (in case you want to view it again). 

! Closing the first Cue Card triggers an option to turn all Cue Cards off.

Your choice

Good for beginners

Ours are

Unchecked

Maximum number of

Simultaneous web

searches

Enter the maximum number of web searches to do simultaneously. The default is 10. 

! If you have problems with web searches, you may wish to reduce the number. 

! If you have a fast computer and lots of memory, you may want to increase it. 

! The maximum possible is 99.

Your choice

Ours are the

default

10

Wallpaper File You may select a graphic file to appear as background to the windows on the TMG

screen.

None

Wallpaper Mode You can choose how the wallpaper file will be displayed by clicking the arrow to the

right.

Your choices are:

! Clip - uses the image as is. 

! Stretch - stretches the image to fill the background window. 

! Stretch Isometric - fills the background window as nearly as possible, but keeps

the image from becoming skewed. 

! Tile - repeats the image to fill the background window.

Your choice

Ours is clip (the

default)

When opening a second

Project

Click on the arrow to the right to choose to: 

! Close the current project 

! Keep both projects open 

! Ask each time.

Ask each time

Date Format You can select to display dates in many different formats. Use the arrow to the right to

make your choice.

dd Mmm yyyy

Format of ID Each individual is given an ID Number by the program. By clicking on the arrow to the

right, you can choose to: 

! Display the ID Number

! The Reference Field

" Info in this field must be entered by you and can be either alpha or numeric

characters.

! Both the ID number & the Reference field

ID Number
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Default Project Path You may enter a path to be used as the default when new projects are imported. The

default is to place them in a PROJECTS folder under the default program user data tree

folder.

Example: C:\Users\Your user name\Documents\The Master Genealogist v7\Projects\

Use TMG’s default

path

Old style date range The default for Old Style dates is 1583-1752, the date span over which the Gregorian

calendar was adopted by various countries. You can change these dates by dialing the

dates you want to use. You might want to change this if much of your research is in

countries that changed to new style dates at a time other than the default.

1583-1752

Program Options - Startup and Exit

Show Welcome window When checked, the Welcome Window will display at startup. Unchecked

Show tips and hints When checked, Tips and Hints will display at startup. Unchecked

Length of Splash screen

display:

You can set the number of seconds that the splash screen (the TMG signature window)

will display at startup. The default is four seconds.

Note: Reducing the time this displays get you into your database faster.

Your choice

Our choice - 2

seconds

Check the website for an

update every

You can download and apply updates to the program that are posted on a TMG web site.

If the Update Wizard finds a patch, it will download and apply it automatically. An

Internet link is required to use this feature. In Check the web site for an update every __

days, enter the interval (in number of days) that you would like to check for updates. If

set to zero, no check will be made. You can still access the web site through the Message

Manager on the Help menu.

Your choice

Dawn - 0 days

Margo - 7 days

Check for messages

every

You can set TMG to go to the Message Manager automatically at the intervals you

select. Dial the number of days you want. If set to zero, the automatic function will be

turned off. You can still access messages through Message Manager on the Help menu.

7 days

Prompt to save layout When checked, you will be prompted to save the Layout on exit if it has changed. Your choice

Dawn - Unchecked

Margo - Checked

Prompt for backup When checked, you will be prompted to back up on exit. Checked

Program Options - Data Entry

Minimum memo font

size

Dial a minimum font size for the memo field by clicking on the up or down arrows. The

smallest possible font is 6 pt.

Your choice

Our choice - 10

Points

Maximum memo font

size

Dial a maximum font size for the memo field by clicking on the up or down arrows. The

largest possible font is 99 pt.

15 Points

Data Entry mode: Beginner (the default)

Advanced - When Advanced is checked: 

! The Beginner mode will be turned off 

! The following data entry fields will be visible: 

" Roles, 

" Event-specific name (name variation), 

" Sort Date 

" Place Styles 

" Name Styles 

" Witnesses 

" Sentence 

Advanced

We strongly

suggest that you

choose this mode

of entry to be able

to fully use all the

program features
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" Sureties

Place/Name labels You may choose how Place labels and Name labels will be displayed on the Tag Entry

screen. Your choices are:

! Enabled - When you tab through the Tag Entry screen, the cursor will stop on the

field label, as well as in the data entry field.

! Disabled - When you tab through the Tag Entry screen, the cursor will not stop on

the field label, only in the data entry field.

! Available only with mouse - When you tab through the Tag Entry screen, the

cursor will not stop on the field label, only in the data entry field. However, you

may click on the label to access it.

Available only

with mouse

This choice gives

you the best of

both worlds.

Spell Checker Internal - If you check this option, selecting the Spell Checker will bring up TMG's

internal Spell Checker.

Microsoft Word - If you check this option, selecting the Spell Checker will bring up

Microsoft Word and will use its spell checking feature. This feature is particularly

helpful for people using languages other than English, since they will have a spelling

dictionary in their own language.

" Grammar Checker - When you select Microsoft Word as your Spell Checker,

you have the option to Also check grammar.

Internal

Use buttons for

Add/Edit/Delete/Primary

on the Details window

If you check this option, four buttons are enabled to the right of the Tag Box to improve

usability for beginners. These buttons are enabled by default for Beginner Mode.

Our comment: These buttons are not necessary and take up space on your details

window.

Unchecked

Use Tabbed version of

Tag Entry

When checked, the tabbed version of the Tag Entry Screen will be used. Unchecked

Open Reminder window

automatically

With this box checked, reminders giving guidance for entering source, citation, and tag

data will open when the data entry screens are opened. If this option is disabled, you can

always open any specific reminder window by clicking the Reminder button on the data

entry screen. Reminders are not available for all source types, sources, and tag types. A

green Reminder button on a Tag Entry, Citation or Source Definition Screen General tab

indicated that a reminder is available.

Checked

Program Options - New People

Check for duplicates

while adding new people

Select this option to enable the duplicate person check when adding new people using the

Add Person Screen or Quick Add Screen.

! Surname - To set the surname option, click on the radio button next to your choice.

" Same soundex - Only select surnames that have the same Soundex code 

" Identical spelling - Only  select surnames with identical spelling

! Given name - To set the given name option, click on the radio button next to your

choice.

" Same first letter - Select all given names beginning with the same letter

" Same soundex - Only select given names that have the same Soundex code

" Identical spelling - Only select given names with identical spelling

 Identical spelling

checked under

surname and given

name

Check only primary

names of existing people

Select this option to only evaluate the primary names of existing people. Checked

Check people of the

same sex only

Select this option to only evaluate existing people of the same sex. Checked

Birth Date- years are

within

To set the birth date option, click on the radio button next to your choice.

! Years are within __ years - Only select birth years that are within the selected range

(default is 10 years)

! Have a year in common - Only select birth years that share a common year 

Years are within &

10 years
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! Exact dates are identical - Only select birth dates that are identical

Disqualify parents,

children, and siblings

Select this option to not consider the parents, children or siblings of existing people. Checked

Display warning in red The Possible matching people: n warning will display in red on the Add Person Screen or

Quick Add Screen if this option is selected. 

Note that the warning only appears when the person being entered is a possible duplicate

based on the criteria selected on this Preferences screen.

Checked

Program Options - Item Tips

Show Item Tips on.... When Item Tips are turned on and you pass the cursor over a field that is not fully

visible, the field will be shown as an Item Tip. 

For example, if the column for Date is not wide enough to see the whole

date, and Item Tips are turned on for the Person View, pass your cursor over the date

field and the full date will be displayed. 

Note 1: This is especially helpful in the Name/Place field of the Details window as you

will be able to read most if not all of your memo field entry.

Note: Item tips may be turned on by using the right click menu while cursor is one a

window

Checked for:

! person view

! Children list

! Siblings list

! Associates

list

Program Options - Exhibits

New image exhibits

should be added as:

You can choose whether new image exhibits should be added as external or internal

exhibits. Your choices are:

! Links to External files - If you select this choice, new image exhibits will be added

as links to external image files.

! Internal Exhibits - If you select this choice, new image exhibits will be added to

the project data tables.

! Ask each time (default setting) - If you select this choice, you will be prompted as

to whether a new image exhibit should be added as an external or internal exhibit.

Your choice

Our choice - Links

to external exhibits

In the exhibit log, when

an external image

exhibit is missing:

You can choose whether missing external image exhibits are displayed as frowny face

icons in the Exhibit Log or whether the image thumbnails will continue to be displayed.

Your choices are:

! Display the thumbnail - If you select this choice, the thumbnail will be displayed

even when an external image file is missing.

! Display the frowny face icon (default setting) - If you select this choice, a frowny

face icon will be displayed when an external image file is missing. 

" This option allows you to open the Exhibit Log, change the focus to "All

Exhibits", and browse the exhibits to quickly identify any external image

exhibits with missing files.

Note: If you choose the thumbnail option you may not realize that the link to the actual

file has been broken as you are seeing what you expect to see. The frowny face is not

what you are expecting to see.

Your choice

Our choice -

Display the frowny

face icon

Program Options - Slideshow

These options affect the Slideshow manager. Your options are:

! Loop - When checked, the slideshow will loop from the end back to the beginning

and start over. Pressing <Esc> will stop the looping and return you to the Slideshow

Manager. When not checked, the slideshow will stop at the end.

! Self-running - When checked, the slideshow will run automatically, pausing on

each slide, then continuing. When not checked, only the highlighted slide will be

shown and you will have to move manually from slide to slide.

! Full screen - When checked, the slideshow will be full screen. When not checked

These options affect the Slideshow manager. Your options are:

We have left the

defaults in place as

we have not used

this feature
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! Loop - When checked, the slideshow will loop from the end back to the beginning

and start over. Pressing <Esc> will stop the looping and return you to the Slideshow

Manager. When not checked, the slideshow will stop at the end.

! Self-running - When checked, the slideshow will run automatically, pausing on

each slide, then continuing. When not checked, only the highlighted slide will be

shown and you will have to move manually from slide to slide.

! Full screen - When checked, the slideshow will be full screen. When not checked,

the slideshow will be in a window.

! Effects - When checked, the Slideshow Manager will honor the effects selected in

the slide properties. When not checked, there will be no special effects.

! Default slide duration - Dial the length of time in seconds that the slide will

display. The default is 5 seconds.

! Self-optimize - If this option is checked, the Slideshow Manager will optimize

itself automatically when frames are no longer in use (after you close the Slideshow

Manager). 

" Whether checked or unchecked, Slideshow Manager will be optimized when

File >Maintenance > Optimize is run.

" If you have a slower system, you should leave this option unchecked and run

Optimize occasionally to clean up the Slideshow Manager.

Program Options - Lists

Minimum font size: Allows you to enter the minimum font size that you want to display in lists. 10 Points

Maximum font size: Allows you to enter the maximum font size that you want to display in lists if the TMG

5/6 method of window resizing is used. 

10 Points

List font: Allows you to enter the font that you want to display in lists. The program default is

Tahoma.

Note: We have both chosen Arial as it is a slightly larger typeface than Tahoma at the

same point size, i.e. at 10 points Arial will appear larger than Tahoma.

Arial 

Show vertical lines When checked, vertical lines will appear between fields in lists.

Note: If lines help your eyes track as you read across your monitor, you will want to

check all 3 options regarding lines.

Your choice 

Dawn - Unchecked

Margo - Checked

Show horizontal lines When checked, horizontal lines will appear between rows of data in list windows. Your choice 

Dawn - Unchecked

Margo - Checked

Show lines for empty

rows

When checked, empty rows will also appear with horizontal lines Your choice 

Dawn - Unchecked

Margo - Checked

Picklist - Simple or

Expanded

Simple Picklist - When checked, a simplified version of the Picklist will be available.

Expanded Picklist - When checked, a Picklist with more features will be available.

Expanded

Confirm multiple

witnesses selected with

the Expanded Picklist

With this option selected, you will get a prompt to confirm your selection of multiple

witnesses from the Expanded Picklist.

Checked

Program Options - Prompts

Prompt for Marriage of

parents

If this is checked, when parents are entered you will be prompted to enter their marriage. Checked
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Prompt for married

names

If this is checked, when a marriage is entered for a female, you will be asked if a married

name tag should be created for her. If you create this tag, she will be listed under both

names in the Picklist and Project Explorer.

Checked

Copy date field from

marriage

If this is checked, you will be asked if you want to copy the marriage date from the

marriage tag to the married name tag.

Unchecked

We like all our 

name tags to sort

together

Assign surname of

Father

If this is checked, when you add a child, the child will be assigned the surname of the

father.

Checked

Access sort date field If this is checked, the cursor will stop in the sort date field on the Tag Entry screen. If it

is not checked, the field will be grayed out and you will not be able to change it. The

cursor will skip it when you are entering data.

Checked

Validate LAT/Long

Value

If checked, an entry in the LAT/LONG will be validated to be sure it is an appropriate

value.

Our comment: This is only important if you are entering LAT/Long values. We would

check this options if we were entering these values.

Your choice

Dawn - Unchecked

Margo - Checked

Prompt to update sort

Date

If checked, when you enter a date you will be asked if you want to update the sort date

field with that new date.

Checked

Prompt to copy principal

sentence to other

principal

If checked, the sentence for the first principal will be copied to the second principal. Checked

Prompt to search for

embedded citations

when deleting a source

Embedded citations that you have entered into event tag memos can reference a source

that you are deleting. When you delete a source, you can, optionally, have the program

search for any embedded citations that reference the deleted source and remove those

embedded citations. Your choices are:

! Never prompt; do not search - When you delete a source, event memos are not

searched for embedded citations.

! Prompt me each time - Each time that you delete a source, you will be asked as to

whether you wish to search all event memos for embedded citations that reference

that source.

! Never prompt; always search - When you delete a source, there is no search for

embedded citations that reference the source.

With a large data set, the search for embedded citations in event memos can take a very

long time. For this reason, the default selection is Never prompt; do not search.

Our comment: If you use embedded citations, you might want to consider this option;

however, keep the above statement in mind.

Never prompt; do

not search

Program Options - Warnings

You can change the way the program warns you in a variety of ways. To turn off the

warning, deselect the box next to it. All warnings are on by default. Many warnings can

be disabled from the warning when it occurs without the need to go to Preferences.

Your warning options are the following:

! Warn when surname in CAPS - When checked, you will be warned when a

surname has been entered in CAPS.

! Warn when surname does not exist - When checked, you will be advised that the

surname does not exist in the data set and asked if you want to add it. 

" This prevents you from inadvertently adding a misspelled name.

! Warn when no primary tag - When checked, if you delete a tag you will be

warned if no primary tag of that type exists.

! Warn before searching for field value - When checked, you will be warned when

All checked
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you press <F2> in a place field that the search may take a while. You must then say

Yes to continue.

! Warn when tag has no citation - When checked, you will be warned if you try to

enter a tag with no citation.

! Warn when citation has no sureties - When checked, you will be warned if you

try to enter a source citation without a surety value. (Advanced Mode only)

! Warn when date is outside the appropriate date range - Determines if and when

a warning will be triggered when you enter an event with a date which is

inconsistent with the start and end years for that event's currently recorded date.

! Warn when date MIGHT be outside the appropriate date range - This option

performs a more liberal comparison between the dates than the option above.

! Warn when place is outside the appropriate date range - Determines if and

when a warning will be triggered when you enter an event with a date which is

inconsistent with the start and end years for that event's place as specified on the

Master Place List.

" e.g., Event date = 1820; Place start year = 1830

! Warn when place MIGHT be outside the appropriate date range - This option

performs a more liberal comparison between the dates than the option above.

Although the dates in the example below are not strictly inconsistent, the event date

does allow for the event to have happened before the starting year of the place.

" e.g., Event date = Before 1840; Place start year = 1830

- In this case, for instance, the user might be inspired to change the event

date from "Before 1840" to "Between 1830 and 1840". [for more info see

help file]

! Warn when selecting multiple witnesses using the simple Picklist - When

enabled, the warning will appear when you click the add multiple witnesses button

from event Tag Entry screen.

All checked

Program Options - Project Explorer

Font size Enter the font size to be used in the Project Explorer. Whatever is

comfortable for

you

Ours - 10 Points

Font name Select the font to be used in the Project Explorer; Tahoma is the default font. Tahoma

Background Click on the select button to select an image to be used for the background of the Project

Explorer.

Empty

Identify Primary Name

with:

You can select Bold or Asterisk to mark primary names in the Project Explorer. This will

also change primary names to bold on the Expanded Picklist (but not on the Simple

Picklist).

Asterisk

Display locks When checked, lock images will be displayed in the Project Explorer, indicating that data

sets are locked. Clearing this box gives you a little more screen space.

Checked

Multiline text When checked, the text for each Subject in the Project Explorer will wrap so that it is all

visible in the window. You can also turn this feature on/off by right-clicking on the

Project Explorer and selecting Multiline text on Project Explorer.

Your choice

Dawn - Unchecked

Margo - Checked

Display ID Numbers When checked, ID Numbers will display on the Project Explorer. Checked

Enable Drag-n-Drop When checked, you can move or copy people in the Project Explorer by selecting them

with the mouse and dragging them in the PE window.

Checked
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Program Options - Tag Box

Note: When you make selections that affect the appearance of the Person View/Tag Box such as adding or removing display columns, you

will need to save those changes by creating a custom layout or by saving your current layout if you are already using a custom layout. If you

do not save your changes, the layout will revert to its current settings the next time that you exit and restart TMG.

Number of rows per tag You can enter the number of visible rows for each tag in the Tag Box. The default is 2. 2

Undated Tags sorted You can choose to have undated tags sorted to the top, bottom, or none (not sorted). Your choice

Dawn - Top

Margo - Bottom

Name Tags Sorted You can choose to have name tags sorted to the top, to the bottom, or by Sort Date. Your choice

Dawn - Top

Margo - Bottom

Identify Primary Event

with:

You can select Bold or Asterisk to mark primary events. Asterisk

Columns Your choices are:

! Show Witness column - When checked, a Witness column, which displays a

checkmark if there are witnesses to this tag, will be shown on the Tag Box in the

Details window.

! Show Exhibits column - When checked, an Exhibits column, which displays a

checkmark if there are exhibits attached to this tag, will be shown on the Tag Box in

the Details window.

! Show Tasks column - When checked, a Task column, which displays a checkmark

if there are tasks attached to this tag, will be shown on the Tag Box in the Details

window.

! Show Age column - When checked, an Age column, which displays the age at each

event, will be shown on the Tag Box in the Details window.

! Show Surety column - When checked, the Surety columns will display near the

right side of the Tag Box and Name Box on the Person View

! Show Source column - When checked, a Source column, which displays a

checkmark if there are source citations attached to this tag, will be shown on the

Tag Box in the Details window.

! Show Memo column - When checked, a Memo column, which displays a

checkmark if the tag memo contains text, will be shown on the Tag Box in the

Details window.

Checked:

• Age

• Surety

• Source  

Unchecked:

• Memo

Show only basic events When checked, only birth, marriage, death, and burial events will show in the Tag Box. Unchecked

Show Children When checked, children will be displayed in the Tag Box, as well as in the Children

window.

Checked

Show witnessed events When checked, witnessed events will display in the Tag Box. Checked

Show non-primary

events

When checked, non-primary events will display on the Tag Box. Checked

Show excluded data When checked, data that has been excluded using a hyphen at the beginning of the field

will show in the Tag Box.

Unchecked

Show Date instead of

Sort Date

When checked, the actual event date will be displayed in the Tag Box rather than the

Sort Date.

Checked

Show History Events for

unlinked people

If unchecked, only those history events which are linked to the Subject will be displayed

on his Person View. If checked, all history events which fall within the time frame of the

Subject's life will be displayed whether or not they are linked to the Subject.

Unchecked
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Show timelines with

color

When checked, selected timelines will be displayed in the Tag Box. If you have chosen

to show timelines on the Tag Box, you can select background and text colors.

Unchecked

Enter key accesses Tag

Entry Screen

When checked, pressing the <Enter> key while the cursor is on a tag in the Tag Box

causes the Tag Entry screen to open.

Checked

Program Options - Custom Styles

Note: You can automatically apply a default custom style to each new data set that is created from scratch or imported from GEDCOM in

the current project or any new project by creating a custom style in File > Preferences > Program Options: Custom Styles. (In other words,

this will not affect data sets that have already been created.)

Name Styles Your choices are:

• U.S. Standard name style

• Custom name style

U.S. Standard

name style

Place Styles Your choices are:

• U.S. Standard place style

• Custom place style

Custom place style

Modify Custom Styles

[click button to modify]

If you have checked Custom for either Names or Places, you must set up your custom

style.

To change the name or place style:

1. Click [Modify Custom Styles].

The Custom Style Modification window will appear.

2. Lookup: Custom Style Modification

Program Options - Reports

Prompt to open file

output:
When creating reports, you can choose whether or not to open reports that have been sent

to file. You have three options for prompts at the end of the report process:

• Never ask; do not open the file

• Always ask

• Never ask; always open the file

Always ask

Flag changes update the

Last Edited date:

When writing reports that change flags, you can choose whether or not to change the Last

Edited date. Your choices are:

• Never

• Always

• Ask each time

Your choice

Our choice - Never

Preferred output types The list of possible output types is presented. If there are file types that you never use,

you may wish to deselect them so that the list of possible types is not so long each time

you write a report. 

• Unselected file formats will not appear on the Report Definition Screen.

Your choice

Add macro codes to

WordPerfect indexes

This is only necessary if you export to WordPerfect. If you do, read TMG Help

regarding this preference.

No suggestion

Program Options - Colors

Merge Candidates Your choice -

Select colors you

like

Lists Your choices are:

• Windows default - If selected, the list portion of the windows will use the

Windows default colors. 

• Custom color for lists - To select a custom color for the list windows:

Custom Color for

lists selected
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• Click the radio button next to Custom color for lists.

• Click the select button. The Color window will appear.

• Click on the color you want or create a custom color and click [OK].

• Apply to layout windows only - When checked, the color will be applied only to

Layout windows, such as Details, Children, etc.

Window backgrounds Your choices are:

• Windows default - If selected, the background portion of the windows will use the

Windows default colors. 

• One color for all windows - To select one color for all windows:

• Click the radio button next to One color for all windows.

• Click the select button. The Color window will appear.

• Click on the color you want or create a custom color and click [OK].

• Customize each window  - To customize each window:

• Click the radio button next to Customize each window, then close the Preferences

window.

• Double-click on the sizing handle at the bottom-right corner of the window you

want to customize. The Color window will appear.

• Click on the color you want or create a custom color and click [OK].

Our choice

Dawn - Customize

each window

selected

Margo - One color

for each window

Program Options - New Project

Note: These options are used only when creating a new project. Thereafter, the same options can be found under Current Project Options:

Places and Current Project Options: Other.

Source Categories: If an output template is not explicitly specified for a source, the formats for long and

short footnotes and bibliography entries are determined by templates which are designed

according to Wholly Genes' interpretation of two leading style guides: 

• Cite Your Sources by Richard S. Lackey (Jackson, Mississippi: University Press of

Mississippi, 1980) 

• Evidence! Citation Analysis for the Family Historian by Elizabeth Shown Mills

(Baltimore: Genealogical Publishing Company, 1997).

• A third option allows you to use a custom set of source categories.

•  Custom categories are initially copied from Mills' categories so that you don't have

to start from scratch.

Custom

Collate sequence: The collate sequence is the order in which letters of your preferred alphabet will appear

in lists. Changes in the collating sequence are necessary to properly sort diacritics,

umlauts, etc. Your choices are:

• Dutch 

• General 

• German

• Iceland

• Machine

• NORDAN

• Spanish

• SWEFIN

• UNIQWT. 

If you are using English, you need not change anything. GENERAL applies to English

and all other languages not listed. After you change the collate sequence, it is necessary

to re-index the project.

General

Short place template: You can change the fields that will be included in the default Short Place. A Short Place

is an additional way of referring to places. It does not include all of the place fields and is

used primarily in charts and other places where the entire set of place fields will not fit.

The default is <[CITY], ><[COUNTY], ><[STATE]>. On the Master Place List you can

assign a Short Place to a specific place record, overriding the default specified here. In

addition to charts, many reports have an option to use the Short Place template when

Use the default

until you have a

need to change
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printing place fields.

Default County Select the country that you want to use as the default for abbreviations and mapping. Pick what would

be appropriate for

you

Program Options - Other

Family View font Size Your choice only affects the font size in the Family View window Whatever is

comfortable for

you

Our choice - 10

Points

Tree View font size Your choice only affects the font size in the Tree View window Whatever is

comfortable for

you

Our choice - 10

Points

Use the TMG 5/6

method of windows

resizing

This box is unchecked by default. 

The standard method of window resizing is that text remains the same size and that data

entry/display space increases/decreases when a window size is increased/decreased. This

is how the windows in most Windows™ applications work. The base font size for lists is

set using the Minimum font size setting on the Program Options: Lists screen and the

base font size for the Project Explorer is set using the Font size setting on the Program

Options: Project Explorer screen.

When using the TMG 5/6 method of window resizing, the font size increases/decreases

in list windows when the window size is increased/decreased. The range of the font size

change in these windows is controlled by the Minimum font size and Maximum font size

settings on the Program Options: Lists screen.

Unchecked

Use icons on the

windows menu

Checking this box will display icons for the Window menu items similar to the icons

used in the Toolbar.

Checked

Allow multiple monitors When this is not checked, window positions are corrected if they are off the visible

screen. When checked, the windows can spread across multiple monitors.

Checked

Prompts/Warnings font

size

Your choice

Dawn - 8 Points

Margo - 9 Points

Heading
From TMG Help files 

(with minor formatting changes)
Our Suggestion

Current Project Options - General

Researcher info This information can be included with reports.

Note: Since identity theft is a current problem, you may only want to enter

your name, email and website information.

Add your information
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Display surnames in CAPS When checked, the surname will appear in capital letters in the Details

window, even though it is not entered in all capitals.

Checked

Display given names in

CAPS

When checked, the given name will appear in capital letters in the Details

window, even though it is not entered in all capitals.

Unchecked

Current Project Options - Colors

Names Your preference

Witnessed events Your preference

Current Project Options - Places

Default country Select the country that you want to use as the default for abbreviations and

mapping.

Pick what is appropriate

for you

Current Project Options - Advanced

Backups, Config files,

exhibit folder etc.

The first time that you run TMG, a default User Data tree will be set up with

program default paths for each of the following paths. New projects will have

the Preferences paths set to the program default user data paths. And when you

restore a TMG v5/6 project, all of the Preferences paths will be set to the

program default user data paths. If you restore a TMG 7 project, the paths in

the PJC file of the project being restored will be used if valid even though

those paths might differ from the program default user data paths. Any invalid

Preferences paths in the TMG v7 project being restored will be reset to the

program default user data paths.

CAUTION: Remember, if you change the default path for any of these options,

then any reports, report definitions, GEDCOM files, Timelines, etc. that are in

the original default folder will not appear when you ask for them. They are still

there, but are in the original default folder. If you want them to appear in the

new default folder then you must move them there using Windows Explorer.

For this reason, if you change any of these defaults, it is a good idea to make a

note of the original path before changing it. You can also use the [Locate]

button in the Open window to locate any of these files in their original folder

when you want them. 

Our choice - 

TMG default

Circa means plus or minus: You can change the number of years that the program assumes when a circa

date is used. The default is 20. This will affect who will be included when a

filter based on a year or year range is set.

Your choice

Our choice - 10 years

Assumed maximum lifespan: You can change the number of years that the program assumes is the maximum

life span of a person if no death event is included. The default is 110. In this

example, if the person was born more than 110 years ago, the LIVING flag on

the Person View will be set to N (NO).

110 years

Save image thumbnails Thumbnails may be used in the Exhibit Log to identify image exhibits. They

may also be used in the Image window on the Person View. Thumbnails are

saved in .JPG format.

Check Save image thumbnail to save a thumbnail of each Exhibit on the hard

drive. If this is unchecked, less drive space will be used, but it will take longer

each time you use the Exhibit Log because each thumbnail in the Log must be

recreated from the images each time. The original image file is not affected in

any way by the presence (or absence) of a thumbnail.

Checked
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Use the thumbnail for the

image window

If Save image thumbnail is checked, then you can also check Use the

thumbnail for the Image window to use the saved thumbnail for the image in

the Image window on the Person View. If Use the thumbnail for the Image

window is not checked, a higher quality image will be used in the Image

window, but it will take longer to draw the screen when you switch Subjects. If

it is checked, the screen will be drawn faster, but the image may not be of as

high quality.

Checked

Thumbnail size Dial the Thumbnail size. This option controls the size (and therefore the

resolution and disk space) of the thumbnail. The size must be between 50 and

2000. The default is 150 pixels and this seems to work well in most cases,

typically taking a 2 megabyte image file and reducing it to a thumbnail of 50k

or less, which loads much faster with little or no loss of visible detail on the

screen. If you maximize the Exhibit Log or the Image window, however, the

image quality may get worse because the same thumbnail is being stretched to

fill a larger space. If you compensate by increasing the thumbnail width, then

that will improve the resolution of the thumbnail, but it will consume more

disk space per thumbnail and will cause thumbnails to take longer to load

(which may defeat the purpose of using thumbnails).

150 pixels

Current Project Options - Other

Source Categories See source categories under New Project Defaults above Custom

Collate Sequence See collate sequence under New Project Defaults above General

Short Place Template See short place template under New Project Defaults above Use the default until you

have a need to change

Welcome message You can enter a welcome message that will appear just after the initial

Welcome screen.

Empty

Currency character Default = $

You can choose whether it appears on the left or the right of the value

Left

Automatic Relation Tag When checked, a tag in the Person View will identify the blood relationship of

each person in the data set to the target person. It will also include adoptive or

foster relationships if the relationship between parent and child is primary. The

default for this feature is OFF, and the Focus ID is 0 (zero).

CAUTION: If you enter new persons after this feature is turned on, you should

click on Refresh relationships. If you do not do this, the correct relationship

may not appear in the new person's screen.

NOTE: Using this feature can take a while if you have a large project.

You can identify the focus person against whom relationships will be

measured. This is usually your ID Number, but you may choose another person

if you wish. If you do not know the number, use the button to select the person

from the Picklist.

Note that you can also select "or the spouse of this person" and this will add

those relationships to the focus person that occur through his/her spouse.

Selecting this spouse option can result in a considerable increase in the time

required to calculate the relationships. Examples of such relationships: 3rd

cousin of his wife, wife of her 3rd cousin, father-in-law (father of her

husband), daughter-in-law (husband of his son), etc. Note that such a

relationship through a spouse requires a marriage or divorce event (not just a

co-parent).

Unchecked



Be sure and click OK when you are finished to save your changes.

After you have selected and saved your preferences you may want to do the following:

If you have chosen the:
Expanded Picklist (File ! Preferences !Program Options: Lists)

Action Choices Our Suggestions

Open the Picklist

Select the way your picklist

displays

Chose:

• Event List

• Only the Person name and Person ID column will display

• The Event tags associated with the Person will be displayed

• Select the tags to display with the Options button

• Column mode

• Select the columns to display with the  Options button

Column mode

Click on the Options button

Note: The display mode you

chose will determine the

choices you see when you

click this button.

In Column mode - Chose the: 

• Columns you want displayed 

• What columns you want accent settings applied to

In Event List - Chose the: 

• Select - allows you select individual tags

• Select All (recommended) -  allows you to select all the tags you have in

your project

• Unselect - allows you unselect individual tags

• Unselect All - allows you unselect all the tags selected

• Chose the tags that will display:

• Only Basic tags

• Non-primary tags

• Witnessed tags - these tags will not show unless you have also selected

Non-primary

• Children

Column mode & the

following columns:

! Person Name

! Person ID

! Birth 

! Death

! Father’s Name

! Mother’s Name

! Spouse’s Name

Accent settings applied:

(default)

! Father’s column

! Mother’s column

! Spouse’s column

In the person view:

To display the full memo field when hovering over it

Action Choices Our Suggestions

 Right click anywhere in the

Person View Details window

Click on the “Show item tips on the Person view”

Note: You can make this choice for other People-related windows you have

open in your layout, by right clicking inside those windows

Checked - all people-

related windows open in

our layouts


